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1 Introduction 
Note: This manual covers configuration tools and system configuration in the 
configuration file normally performed by Consat. 

The presented tools/settings are only available to SuperUsers. 

 

2 Save Command Lines for Role 
Under the menu alternative Save Command Lines for Role you set up a select number 
of functions for the selected role. 

 

Note: This configuration window only applies to (the loaded) role configuration, 
not individual user configurations. 

 

You can remove the users ability to configure the application themselves, decide if the 
application will connect to the central system from the start, etc. (see below). 
 

 

 

To make any changes/enter configuration, select the role in the top “group name” menu. 
Enter/edit settings and click on the Save button below. 

 

Options Description 

Role Which user role is affected by the setup. 

No user 
configuration 

Changes are saved to a file at the application level, i.e. users cannot modify 
their settings. 

Auto start The application connects automatically to the last system used (the user 
does not need to click on ”connect”). 

1. Select the user role that is to be configured 
 
 
 
 

2. Check/uncheck boxes, enter paths etc. (see 
below) to configure the user role 
functionality. 

 
 
 
 

3. Click Save. 
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Options Description 

No system setup The option ”System” is not available in the File menu. 

Use docking 
windows 

The windows are docked according to the specifications in the file 
MOBILITY_DOCK.XML See “Docking Windows” below. 

Maximized Maximize the application on the actual screen. 

No status bar Hide the status bar usually located at the bottom of the application 
(including user and group). 

Tool: Full Screen The application starts with application and selected tool/tools in full screen 
mode (note that only one tool is presently full screen enabled/designed for 
full screen). 

Show Docking 
Config 

Activate the menu option “Configure window position” under File > Setup, 
where the window’s position can be specified. 

Docking Windows Name of the file for docking windows if other then default. If you leave the 
field blank, the default file, MOBILITY_DOCK.XML. will be used. 

To create a specific configuration, locate the the default file (found here: 
%AppData%\Consat Telematics AB), copy it to the same folder. Then 
browse and edit the copy with the Docking Windows Configuration tool, 
see the following chapter. 

Config File Name Name of the configuration file which is not default (The default file name is 
I4mFrameWork.exe.config). 

Default Help File Location of the help file. 

Selected Tools List of plugins (each plugin may contain several tools) are selected at 
startup, in addition to the role/user configured plugins. 

Show Classes The tools opened at startup. 

Providing the whole name of a class will automatically show the window’s 
call name at startup. 
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3 Configure Tool Placement in Application 
File > Setup > Configure Docking Windows 

To set the placement of the tools in the various application tool windows and to configure 
which tools are to be active on startup, select Configure Docking Window in the 
Files/Setup menu. 

With this tool you can also deactivate specific close tool tab buttons, to prevent the users 
from closing essential tools like Voice Communication and thus miss important 
messages/calls. 

 

With the application disconnected from the central system, you will find the Docking 
Window Configuration window in the Files Menu, see below. 

 

 

 Workflow 

Docking Window Configuration is a pure file editor with a simple workflow: 

1. You Browse the “docking window” configuration file you want to edit, either the 
default configuration file or a specific configuration file (click on the Browse button 
to open the browser). 
 
The window configuration file(s) are located here: [%AppData%\Consat Telematics 
AB] 
 

2. Load the file. 

3. Edit it with the various editing functions, see the following page. 

4. Save the edited file with the Save button. 

 

Note: You cannot save the file with another name using Docking Window Configuration, 
to create a new, role-specific, file you must first copy the default file (and give the copy a 
suitable name) in the folder and then edit the copy with Docking Window Configuration. 
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 Overview 

The editing window is very simple: Below the top browse file section, all tools are listed 
(with their plugin names, not the tool names), regardless of if the users have them 
activated or not. 

For each tool/row there are a few basic settings, see description below. 
 
 

 

 

Header Description 

Window Full Name The name of the tool plugin. 

Window Docking The application window the tool is to be placed in: 
Left/Top/Bottom/Right application window, or 
select “None” for floating, undocked tool window. 

Auto start Check the box to make the tool open at startup 

Display Screen Place the tool on the primary or secondary display 
(if available) 

Remove Close 
Button 

Check the button to remove the close (X) button 
on the tab. With the button removed the user 
cannot close the tool and potentially miss 
information/calls etc. 

 

 

  

Browse, load and save configuration file 
 
 
 
 

View/Edit individual plugin/tool settings 
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4 (Local) Configuration File 
Configurations can be stored both in the system database and in a local configuration file. 
The file can function as fallback when the connection to the database is lost. 

 

 

The configuration file, I4mFrameWork.exe.config, can be found in the application 
installation directory:  

C:\Program Files (x86)\ Consat Engineering AB\ITS4mobility Traffic Studio 

 

The location of the file with the individual user settings can vary depending on the 
Windows version. It can be, either: 

C:\Documents and Settings\user\Application Data\Consat Engineering AB\ITS4mobility 
Traffic Studio 

Or: 

C:\Users\användare\AppData\Roaming\Consat Engineering AB\ITS4mobility Traffic 
Studio 

 

You can see the user folder by typing [in the command prompt]:  

C: \>echo %appdata% 

C: \Users\’user’ \AppData\Roaming 
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 Configure Login Within / From Outside the Domain 

This functionality is intended for users working outside the server’s domains and logging in 
with usernames and passwords. 

 

1. Open the configuration file in an editor. 

2. Change the parameter UseClientApplicationService to True to activate login from 
outside the domain (see below). 

</setting> 
<setting name="UseClientApplicationServices" serializeAs="String"> 
        <value>False</value>  

False means that the login takes place within the domain. 

True means that the login takes place outside the domain. 
 

 

Configuration section trafficstudio.authentication (Traffic Studio 
version 20.6 or later):  
Defines which login providers that should be used when Traffic Studio starts and validates 
the user credentials. If this configuration section exists, the login will use this section 
configuration. Otherwise it will use the old UseClientApplicationServices settings 
described above. Thus, this section overrides the old flow.  

When setting it up see example below. 

Under section ”Logins”, add the ordered list of logins to attempt e.g. reference to provider 
e.g. if one wants a fallback from normal login using file credentials. 

Providers: 

• AuthProviderWebservice – normal login form calling a backend service (implemented 
by Tmix.Cap.SecurityAuthentication.WebApp). Web auth (a section later that 
configures it) – same as: UseClientApplicationServices 

• AuthProviderActiveDirectory – using active directory of the machine – same as: 
UseDBConfigMgmt (see below). 

• AuthProviderFile – using a local file – when traffic studio must work internet/network 
e.g. critical tram operation 

• AuthProviderOpenId – using open-id login where traffic studio opens a web browser 
window to a centralized authentication provider. CTS uses IdentityServer 
(implemented by Tmix.Cap.Security.IdentityServer.Process) which can contain links to 
external login provider e.g. azure login. 

o acr_value - a parameter in open-id where traffic studio can hint it wants to 
use a specific provider – same key must be configured on that service. 

o Uri – list of uri to try and connect to – uses the first that respond giving it 
endpoint configuration. Supports some dynamic formatting parameters to 
enable generic configuration. 
 

<configSections> 
    <section name="trafficstudio.authentication" 
type="I4mFramework.Auth.Data.Cfg.AuthenticationSectionHandler,I4mFramework.Auth" /> 

 

<trafficstudio.authentication> 
    <Configuration xmlns="http://its4mobility.com/trafficstudio/authentication.xsd"> 
      <Logins> 
        <Login provider="openid" /> 
        <Login provider="webservice" /> 
      </Logins> 

http://its4mobility.com/trafficstudio/authentication.xsd
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      <Providers> 
        <AuthProviderWebservice enable="true" name="webservice" /> 
        <AuthProviderActiveDirectory enable="true" name="activedirectory" /> 
        <AuthProviderFile enable="true" name="file" /> 
        <AuthProviderOpenId enable="true" name="openid">  acr_values="idp:azure-common"  
          <Uri>{Application.InstallUriHost:https://$/Tmix.Cap.Security.IdentityServer}</Ur
i> 
          <Uri>https://localhost/Tmix.Cap.Security.IdentityServer</Uri> 
          <Uri>https://i4mtest5.tmix.se/Tmix.Cap.Security.IdentityServer</Uri> 
          <Uri>https://i4mtest5.tmix.se/Tmix.Cap.Security.IdentityServer</Uri> 
        </AuthProviderOpenId> 
      </Providers> 
 
    </Configuration> 
  </trafficstudio.authentication>--> 

 

Logging in from Outside the Domain (Username + Password) 
The login window shows up when the application is started if the user logs in from outside 
the domain. The user requires a username and a password to log in. 

 

  

https://localhost/Tmix.Cap.Security.IdentityServer%3c/Uri
https://i4mtest5.tmix.se/Tmix.Cap.Security.IdentityServer%3c/Uri
https://i4mtest5.tmix.se/Tmix.Cap.Security.IdentityServer%3c/Uri
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5 Configure Available Systems 
(TrafficStudio Admin) File > Setup > System 

 

You can add, remove and edit available system connections for the loaded user/role. 
Below is a summarized description of the parameters for the configuration of the system. 

 

• Do not hesitate to contact Consat Telematics if you require assistance. 
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Add a New System Connection 
 Click on the Add button. A new window, System Definition, will open with 

configuration fields on four tabs. 

 

 Click on the “System WCF” button in the top right corner of the System Definition 
Window. A System Settings window will open with the top Uri field selected. Enter the 
System server name after the default “http://”. 

 

 Click on the green OK button, the system settings will load filling out the configuration 
fields on all the System Definition window tabs. 
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 Select the Services tab and enter the Traffic database User Name and Password. 
Click on the Test Connections button to check all connections (see following sub-
chapter for mor information about the services and the connections check). 

 
 

 Enter a suitable System name in the top name field and click on the green Apply 
button to save your new systems settings. 

 

 

Edit an Existing System Connection 
1. Select the system to edit in the window Available Systems. 

2. Click on Edit. A new window, System Definition, will open with tabs and many 
text fields in order to create a new system. See the following sub chapters for 
information about the system settings. 
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Copy an Existing System Connection 
1. Select the system to copy in the window Available Systems. 

2. Click on Copy. A new system will appear in the list of available systems. Edit the 
system name. See the following sub chapters for information about the system 
settings. 
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System Definition (Add/Edit a System Connection)  
File > Setup > System Definition 

 

• After making changes, click on Apply (at the bottom of the window) to save. 

 

System Definition: General 

  

 
 

View Available/Locked Functionality 

Click on the “?” button to open the Key Code window. Here, all tools and all key-code 
controlled functionality are listed. Locked tools/functions have locked symbols, see below. 

  

Key  
User’s software key (code) 

System Type  
Select between Small, Medium and Large, 
depending on the system’s size. 
 
The type will show or hide certain parts of the 
system.  
 
Small is for systems missing traffic data. 
 
Import is used for accessing/verifying imported 
data in an import system (separate from the 
production system). When connected to such a 
system the Traffic Data Importer and Planned 
Traffic tools are used for controlling the import 
and verifying the data imported to the import 
system, before deploying the data to the 
production system. 

Name 
System’s name (must be unique and 
cannot be omitted) 
 

Locked Functions 
All non-available tools and functions are 
highlighted with lock symbols. 
 
Tip: Use the free text filter on top to 
quickly find a specific plug-in/tool in the 
list 
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System Definition: Message Router  

The Message Router Client handles the configuration for the message routers. The button 
“Test Connection” verifies the connection to the various servers. 

 

Parameters Description 

Host IP address or host name for the connection. 

Port Id TCP/IP port for the connection 

 

  

IPv6 Address 
Check to use v6 IP address 
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System Definition: Appearance  

Parameters for how the vehicle’s numbers are shown in the application and how the 
deviations will be displayed (+ or – for delays). 

 

Vehicle Numbering 
Determine how the system 
addresses will be displayed. Each # 
represents a digit to be shown. 
E.g. ____#### means that the last 
four digits of the vehicle number will 
be shown. 

Late prefix 
Display a “+” or a “–“ for lateness. 

Show Only Resource Vehicles 
Check to only show (Real Time) vehicles 
included in the system vehicle database. 
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System Definition: Services 

Settings for the services used in the system. 

 
 

• The test Connections button runs a service connection test. Green OK symbols 
highlight working connections. Red crosses indicate missing connections (check 
Uri). 

• Tip: Tooltip a red cross to view error description. 
 

 

 



Traffic Studio Super User Reference Manual 
 

Ver.25.7.(X)   20 /54  

 

 
 

 
 

 

Privileged 

Parameters Description 

TS API A common secure Traffic Studio API for multiple services. In a future 
release, this one authenticated API will handle all services. 

 

Note: In the current release resources and assignments are 
supported.   

Resources Resource information 

Two-way-
text 
messaging 

Manages two way text messages between the vehicles and the 
central system. Check Read only box to only allow reading of 
messages. 

Faults Fault management (needed for presentation of vehicle/display fault 
status and history). 

Multimedia Traffic information task content (announcements, text 
announcvements, disturbances). Check Read only box to not allow 
creating new traffic information tasks. 

Statistics Statistics server 

Data import Import of traffic data 

Vehicles 
Statistics Db 

Logged data, vehicles 

Events Events server. Check Read only box to not allow user to change event 
configurations. 

Text to 
Speech 

Server for text-to-speech functionality 

Vehicle 
Manager 

Fault report for vehicles 

Assignments Create vehicle assignments. Check Read only box to only allow 
viewing of assignments. 

Equipment Switch surveillance. 

Connection 
monitor 

Interchange data. 

Display At-stop displays 

Report Sheet User report functionality 

Station 
management 

Station Manager functionality 

Forecast Forecast history 
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Parameters Description 

GeoCoverage Snowplow service for monitoring plowing status of route sections. 

Geocoding Service for geographivcal positions and adresses (used by the Search 
Street tool). 

Transit Map Transit Map (logical map) 

Road 
Situation 

Road status information (external source) 

Charging 
Management 

Charging point service. 

Planned 
Traffic 

Traffic database. User name and password to log in to the traffic 
databases. The user is saved in the traffic database deciding which 
companies can be accessed. 
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System Definition: Read Only Services 

Some services can be set to be read only – only allowing the users to view information, 
not create tasks, make assignments, save changes, etc. This is controlled with checkboxes 
to the right of the services list, se below. 
 

• Check the corresponding boxes and click on the Apply button for the setting to take 
effect. 
 

 

  



Traffic Studio Super User Reference Manual 
 

Ver.25.7.(X)   23 /54  

 

 
 

 
 

 

Privileged 

System Definition: Extra (Various Settings) 

System data usage/presentation settings, including settings for setting up multiple 
system instances to separate presentation, messaging, information etc. between “sub 
systems” sharing the same system. 

 

 

 

Parameters Description 

Drivers Display of drivers on / off 

Passenger Counter Display of passenger counter on / off 

Duties Display of duties on / off 

Show vehicle speed Display vehicle speed data on / off 

Use server time zone For connecting to system in other time zone – use server local 
time. 

Disable Toaster Disable Notifications. 

System instance Selection of system instance in server (menu). Click on the ”Load” 
button, to load the menu with all available items. 

The choice “All” will allow access to all instances. 

Principality Selection of principalities (menu). Click on the ”Load” button, to 
load the menu with all available items. 

The choice “All” will allow access to all principalities. 
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Parameters Description 

Brand 

 

Adapts tool labels for different system setups 
(transit/snowplow…GTFS) 

Transit: Standard public transport Transmodel based terminology. 

Note: The GTFS setting adapts the terminology for local 
Canadian terminology. See the chapter 2 Terminlogy list in the TS 
reference manual. 
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 Save Configurations in Database 
or in local Configuration File 

It is possible to define how the application’s configurations will be saved, whether to a 
database and/or to the application’s local configuration file (FrameWorkConfig.xml, see 
chapter 9 Settings in the Configuration File for its location). 

Three excerpts are shown below from the configuration file. The first two decide if the 
configurations will be read and written from/to the configuration file. The third one 
decides if it will be read and written from /to a database. 
 

Read the Configurations from the Configuration File 
<setting name="ReadUserConfigurationFile" serializeAs="String"> 

<value>True</value> 
</setting> 

The settings in the file are colored in red if the parameter above is set to ”True”. 
 

Write the Configurations to the Configuration File 
<setting name="SaveUserConfigurationToFile" serializeAs="String"> 

<value>False</value>  
</setting> 

In the example above, the configurations are written to the file FrameWorkConfig.xml. In 
this case, the parameter is set to “True”. 

• Note: The application reads the configurations from the file regardless if the 
parameters above are set to True or False. 

• Note: Even if the application should normally be read from the database, the 
parameters can still be set to “True”, which means that the configurations will use 
the local configuration file as a backup if the database cannot be reached. 
 

Read and Write Configurations from / to the Database 
<setting name="UseDBConfigMgmt" serializeAs="String"> 
  <value>True</value> 

</setting> 

 

True means that the application will first read and write from/to the database.  

False means that the application does not read nor write from/to the database. 

 

 

Database-IP 
The servers address must be provided when using a server to store the parameters. 

<setting name="ServerConnectionString" serializeAs="String"> 
<value>i4mtest1:80</value> 

</setting> 
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6 Configuration Manager (Super User) 
File > Setup > Configuration Manager 

Individual Traffic Studio Configurations are administered with the Configuration 
Manager, a floating configuration window available to Power and Super Users. 

 

Note: As Super User, you have access to extra functionality in this tool for viewing and 
comparing configurations in detail. 
 
For information about how to load, edit and save configurations, see the Administration 
Manual. 

 Configuration Manager Window: Overview 

The floating Configuration Manager lists all individual configurations in your system. 

Like other list views, the Configuration Manager list can be filtered using a free text filter, a 
type filter, and sorted by any column to allow focusing on the information you need. 

 

 

 

  

 

 

 

 

Function buttons for loading the Traffic Studio application with a selected 
configuration, for saving the currently loaded configuration to the same or 
another target and removing (deleting) a selected configuration. The 
Import/Export buttons lets you import or export a configuration from/to a 
file. 

In the configuration details section, you view details 
for the selected configuration. 
Here you also select a user/role/computer 
configuration to save the currently loaded 
configuration to. 

Free Text Filter: Filter the configuration list 
to only include rows with at least one 
matching cell. 

Click on a column header to 
sort the list by the content 
in that column. Click again 
on the same header to sort 
in reverse order. 

Icons differentiate role, 
user and computer 
configurations 

Use the type filter to only view 
configuration types of interest: 
Gropups/Users/Computer. 
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Header Description 

Typ Symbol indicates configuration target/user: 

 - Role 

 - User (logged in as role…) 

 - Computer (logged in as role…) 

User User Name. 

Role Role Name 

Computer Computer Name 

Modified Time Time Stamp, showing last change 

ID Configuration ID 

 

 View complete configuration (selected role) 

As Super User, when you select a role in the tool list, that roles’ complete configuration – 
including plugins, settings, key code, system configurations, databases, etc. is displayed in 
a configuration tree in an expanded section to the right. 

 

 

 

 

Free text Filter, Configuration Tree 

Double-Click on the open symbol to 
view the access status for TS tools 
and functions. Locked tools/functions 
are displayed with lock symbols. 
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Note: This function is mainly intended for Consat personnel that needs to troubleshoot or 
set up new systems rationally and quickly. All individual configurations cannot be 
documented here (everything is documented in the application source code.)  

 Compare two role configurations 

You can easily compare the configurations of two selected roles. Differing configurations 
and sections not included in both roles are highlighted with different colors. You can also 
choose to exclude these categories to focus on differences, etc. 

 

 Select the first role by clicking the list – that roles configuration tree will show in the 
expanded section to the right. 

 

 

 Check the “Compare configurations” box to enable the comparison function. A new 
configuration tree section is added to the right. A “Filter” menu for selecting 
comparison categories is added. 
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 Click the role list to select the role [configuration] to compare with the first selected 
role. 
 
Note: Depending on the Filter menu selections different comparison categories will be 
included in the two configuration trees. With all three categories checked in the menu, 
everything is included in the presentation. 
 
Configuration nodes not included in the other, compared role [configuration] is 
highlighted brown in the configuration trees (works both ways). To exclude these 
configurations from the presentation, un-check the “Show settings that don’t exist” 
item in the menu. 
 
Configuration nodes that are included in both role configurations, but have differing 
values/settings, are highlighted purple. 
To exclude these configurations from the presentation, un-check the “Show settings 
values that are NOT same” item in the menu. 
 

 

Tip: To focus only on the differences between the two configurations, un-check the 
“Show settings values that are the same”. 
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Note: To make another comparison, un-check the “Compare configurations” box and start 
over with step 1.  

These purple highlighted nodes are 
included in both configurations but 
have differing values/settings. 

These brown highlighted nodes are 
not included in the other 
configuration. 
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7 Paths to Web Services, Login Outside the 
Domain 
If the user needs to log in via a web service (while using the application from outside the 
domain.)  The path, or URL, provided by Consat after the installation, needs to be 
configured. 

 

Login Through Client Application Services and Active Directory 

 

 

• Note: It is impossible to log in as a Super User from outside the domain. 
 

Path to the Web service 
<appSettings> 
<add key="ClientSettingsProvider.ServiceUri" value="http://xxx"/> 

 

 

<providers> 
<add name="ClientAuthenticationMembershipProvider"  
type="System.Web.ClientServices.Providers.ClientFormsAuthenticationMembershipProvide
r, System.Web.Extensions, Version=3.5.0.0, Culture=neutral, 
PublicKeyToken=31bf3856ad364e35" serviceUri=http://xxx 

 

 

<providers> 
<add name="ClientRoleProvider" 
type="System.Web.ClientServices.Providers.ClientRoleProvider, System.Web.Extensions, 
Version=3.5.0.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35" 
serviceUri="http://xxx" cacheTimeout="86400" /> 

 
 

 

• Note: When a user logs in for the first time in a group, the group’s default 
configuration is used, before being saved in the user’s configuration file.

Path to the web service 
 

Path to the web service 
 
 

Path to the web service 

http://xxx/
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8 Let Users Save Configuration Changes, or 
Not 
In some situations, you may want to limit or stop users from saving changes being made 
to the configuration. I.e. let the application always return to its default configuration for 
each session. 

(For instance, when several users share an account or when changed configurations has 
been known to cause problems.) You can also choose allow only Superusers to save 
changes to the configuration (see example below). 

 

<setting name="DbConfigMgmtReadonly" serializeAs="String"> 
                <value>False</value> 
            </setting> 
            <setting name="DbConfigMgmtReadonlyTables" serializeAs="Xml"> 
                <value> 
                    <ArrayOfString xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema"> 
                        <string/> 
                    </ArrayOfString> 
                </value> 
            </setting> 
            <setting name="DbConfigMgmtReadonlyPlugins" serializeAs="Xml"> 
                <value> 
                    <ArrayOfString xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema"> 
                        <string/> 
                    </ArrayOfString> 
                </value> 
            </setting> 
            <setting name="DbConfigMgmtReadonlyPluginSections" serializeAs="Xml"> 
                <value> 
                    <ArrayOfString xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema"> 
                        <string/> 
                    </ArrayOfString> 
                </value> 
            </setting> 
            <setting name="DbConfigMgmtReadonlyPluginVariables" serializeAs="Xml"> 
                <value> 
                    <ArrayOfString xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema"> 
                        <string/> 
                    </ArrayOfString> 
                </value> 
            </setting> 
            <setting name="DbConfigMgmtApplyReadonlyRulesForNonSuperUser" serializeA
s="String"> 
                <value>False</value> 
            </setting> 
            <setting name="ForceSystemSetup" serializeAs="String"> 
                <value>False</value> 
            </setting> 
 

Example 
In this example configuration all tools are read only for all but superusers. 

Plus: Vehicle Setup is read only for all, including superusers. 
 

<setting name="DbConfigMgmtReadonly" serializeAs="String"> 
            <value>False</value> 
        </setting> 
        <setting name="DbConfigMgmtReadonlyTables" serializeAs="Xml"> 
            <value> 
                <ArrayOfString xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

http://www.w3.org/2001/XMLSchema-instance
http://www.w3.org/2001/XMLSchema-instance
http://www.w3.org/2001/XMLSchema
http://www.w3.org/2001/XMLSchema-instance
http://www.w3.org/2001/XMLSchema-instance
http://www.w3.org/2001/XMLSchema
http://www.w3.org/2001/XMLSchema-instance
http://www.w3.org/2001/XMLSchema-instance
http://www.w3.org/2001/XMLSchema
http://www.w3.org/2001/XMLSchema-instance
http://www.w3.org/2001/XMLSchema-instance
http://www.w3.org/2001/XMLSchema
http://www.w3.org/2001/XMLSchema-instance
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                    xmlns:xsd="http://www.w3.org/2001/XMLSchema"> 
                    <string /> 
                </ArrayOfString> 
            </value> 
        </setting> 
        <setting name="DbConfigMgmtReadonlyPlugins" serializeAs="Xml"> 
            <value> 
                <ArrayOfString xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
                    xmlns:xsd="http://www.w3.org/2001/XMLSchema"> 
                    <string /> 
                </ArrayOfString> 
            </value> 
        </setting> 
        <setting name="DbConfigMgmtReadonlyPluginSections" serializeAs="Xml"> 
            <value> 
                <ArrayOfString xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
                    xmlns:xsd="http://www.w3.org/2001/XMLSchema"> 
                    <string>VehicleSetup</string> 
                </ArrayOfString> 
            </value> 
        </setting> 
        <setting name="DbConfigMgmtReadonlyPluginVariables" serializeAs="Xml"> 
            <value> 
                <ArrayOfString xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
                    xmlns:xsd="http://www.w3.org/2001/XMLSchema"> 
                    <string /> 
                </ArrayOfString> 
            </value> 
        </setting> 
        <setting name="DbConfigMgmtApplyReadonlyRulesForNonSuperUser" 
            serializeAs="String"> 
            <value>True</value> 
        </setting>  

http://www.w3.org/2001/XMLSchema
http://www.w3.org/2001/XMLSchema-instance
http://www.w3.org/2001/XMLSchema
http://www.w3.org/2001/XMLSchema-instance
http://www.w3.org/2001/XMLSchema
http://www.w3.org/2001/XMLSchema-instance
http://www.w3.org/2001/XMLSchema
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9 Configure the Application Log 
The application’s logs are saved in this location: 

 

C:\i4m\var\log\TrafficStudio\TrafficStudio 

 

To change location, edit the file value below. 

The SyslogAppender IP and port can also be edited, see below. 
 
 

 
<log4net> 
        <!-- Logger for Traffic Studio: --> 
        <appender name="ProcessIdRollingFileAppender" type="I4mFormControls.ProcessI
dRollingFileAppender"> 
            <file value="c:\i4m\var\log\TrafficStudio\TrafficStudio" /> 
            <appendToFile value="true" /> 
            <maxSizeRollBackups value="10" /> 
            <maximumFileSize value="1MB" /> 
            <rollingStyle value="Size" /> 
            <staticLogFileName value="true" /> 
            <layout type="log4net.Layout.PatternLayout"> 
                <conversionPattern value="%date [%-6thread] %-
5level (%logger{1}) - %message%newline" /> 
            </layout> 
        </appender> 
        <appender name="RemoteSyslogAppender" type="log4net.Appender.RemoteSyslogApp
ender"> 
            <param name="RemoteAddress" value="192.168.0.15" /> 
            <param name="RemotePort" value="514" /> 
            <facility value="local7" /> 
            <layout type="log4net.Layout.PatternLayout" value="%date{yyyy-MM-
ddTHH:mm:ss.ffffffzzz} %P{log4net:HostName} [%-16thread] (%logger{2}) - %m%n"/> 
        </appender> 
        <root> 
            <level value="ALL" /> 
            <appender-ref ref="ProcessIdRollingFileAppender" /> 
            <appender-ref ref="RemoteSyslogAppender" /> 
        </root> 
    </log4net> 
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10 Application Viewer Tool 
This remote troubleshooting tool provides information about a users’ TS application 
version, configuration etc. It includes remote diagnostics retrieval and interaction tools 
handling reboot/updating a users’ application/configuration. 

When in contact with a customer with Traffic Studio problems you can use Application 
Viewer to check his/her configuration etc. 

 

• Note: To use App Viewer, the plugin needs to be added as well as the key enabled 

 

 

• You run the tool in TS connected to the users system. 

 

• Application viewer is accessed in Tools >Application Viewer 
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 Tool Overview 

The basic tool view is a list of all current TS sessions on the connected system. Each client 
session is listed in a separate row. 

 

 

 

 

Header Description 

 

 Button to open Diagnostics Form window for client session, 
see following sub chapter. 

 

System Adress User application system address. 

Name Includes information about: 

• Traffic studio version 

• Login  domain\login name (name) 

• Role 

• Computer name 

• Process ID 

• Plugins 

• Memory 

• Application start time 

• Total ?? 

• .Net version 
 

Status Application status: 

• APT_APP_STARTING 

• APT_APP_RUNNING 

• APT_APP_TERMINATING 

Last Update Time Stamp, showing last change 

Keycode Alpplication Key code. Copy to check/verify in keycode application. 
 

 Button to copy key 

 

Free Text filter 
Path to log (copy 
to use). 

xxx 

Reloade/Update list 
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Note: the row content can be copied to better see details, such as which plugins are 
used. 

 

 

• Log for application viewer can be turned on 

 

 

  



Traffic Studio Super User Reference Manual 
 

Ver.25.7.(X)   38 /54  

 

 

 
 

 

Privileged 

 Request Diagnostics 

 Click on the Diagnostics button to open Diagnostics form window: 
 

 

  Click Request Diag to get the current state of the user client 

 The result is a screenshot of TS as well as the latest TS log available. 

 

 Click Save result to save diagnostics to local computer 
you’ll get a zipped folder containing: 

 

 

 The latest log file from the client can be found in further down in the users folder: 
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 Request [User Application] Shut Down 

The Diagnostics form includes a shut down/reboot request function. Use it to remotely 
shut down/reboot the client application. This normally includes a client heads up 
dialogue/message. 

 

“Request shut down” + “Ask” +”30”  + the message “Need to close application for 
updates.”  Will give the client user a dialog box 30 sec before closing the application 

 

 

Dialog displayed in the Client application: 

 

 

• the user will have a chance to deny the closing of the app. Rejected shutdown will be 
displayed like this: 
 

 

 

• The dialog message and timeframe for a shutdown request can be altered as needed. 

 

 

 

 

  

A text message can also be sent to 
the client user, se example below 
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11 Charge Points: OCPP History 
The OCPP History view (for a specific charger) is accessed through the Charge Point 
quick menus: 

 

This view, available through the charge point quick menu, lists all transactions over the 
OCPP protocol, which is used to communicate with most chargers. 

 

• The transaction list covers a specified period. Define the beginning and end of the 
period in the top section and click load to load these transactions. Change at any 
time and click Load to modify your search period. 

• Each row in the list shows an information transaction to/from the charger (request-
response). 

• Separate message and free text filters for table contents and data allow you to 
quickly find matching items. 

• Select a row (transaction) to view it in the details section to the right (expanded with 
the details button). 
 
 
 
 
 

  

   

Search Period 

Select start and end time and 
click the Load button. 

Details: Contents, selected transaction to/from 
charger. 
 
Presentation menu: Formatted/Raw/Metadata. 
 
Metadata is a compact presentation of the 
transaction. 
 
Raw is the transaction unformatted. 
 
Formatted (normal view) is a “pretty”, formatted 
presentation of the complete transaction. 
 
Check “Show related” to also display the related 
message (request/reply, depending on selected 
transaction) in the selected presentation mode. 

Filters 

Message type filter, table free text filter 
and data free text filters. View only 
matching items. 

Details show/hide 



Traffic Studio Super User Reference Manual 
 

Ver.25.7.(X)   42 /54  

 

 

 
 

 

Privileged 

12 Configure Custom Vehicle Alarm Events 
As a Superuser you have access to the Vehicle alarm, customized event configuration, in 
the TS Event Configuration tool. 

This allows you to set up multiple instances of the event, linked to the vehicle alarms of 
your choice (if you know their individual probable cause number – check with the vehicle 
team for an up-to-date list of the vehicle alarms/numbers). 

The event will trigger when the alarm goes active. 

 

Note that the same event type will be triggered by all configured event instances. You will 
need to differentiate between the alarm triggered events by the text you configure for 
each instance. This text is added to the Event Description text and thus you can free-text 
filter the event list to find/monitor these event instances. 
 

 Click on the Add button to add a new instance/row 

 Check the “active” box to enable the instance 

 Set the event (instance) priority 

 Enter the probable cause code 

 Enter a suitable text that will be added to the event description. 

 Repeat the above to add more instances/vehicle alarm events. 

 Save your changes. 

 

 

  

Add a new event instance/row to 
the bottom of the list above. 

Enable/activate event instance. 

Set the priority of the event instance 

Probable Cause Number: The Vehicle alarm 
“probable cause” number, identifying the 
specific vehicle alarm. 

Instance-specific text added to the Event 
description. Use for identifying specific event 
instance. 

Remove/delete event instance/row. 

Save changes 
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13 Create, Administer Transit Maps 
• Note: The current version of the tool “My Transit Maps”, used for creating and 

administering Transit Maps, is considered an “inhouse” tool, mainly intended for Consat 
personnel. Future versions will have fine tweaked workflow and more use friendly 
functions and will be available to User Administrators – the tool descriptiio will then be 
moved to the Administrator manual. 

 

My Transit Maps, Transit Maps in Edit mode 
To create, edit and administer transit maps, two Traffic Studio tools are used: My Transit 
Maps, for listing and administering transit maps, and the Transit Maps tool used in edit 
mode, for “building”/editing the maps. 

 

• Transit maps consist of a background image, showing parts of or the whole line 
network, and on top of this, the logical stop points and line paths the vehicle symbols 
are to follow on the map. To create the finished map you simply position the stops the 
line paths between them, using Transit Maps in edit mode. 

 

Toolset Overview 
 

 

 

 

 

 

 

 

 

 

 

 

Transit Maps (Edit Mode) 
With Transit Maps in edit mode, all included lines and paths (consisting of the links between the 
stops) are presented in a section to the left. 
You add line and route data in this section from the Planned traffic tool using the shortcut men 
(see the following step by step sections for how to do this). 
Key-commands are used to place the listed route stop points and the point-in-links that create 
the paths on the map. 

My Transit Maps 
The My Transit Maps tool lists all created Transit Maps and allow you to select maps for editing in 
the Transit maps tool. 
My Transit Maps is also used for creating new transit maps and inserting/changing the background 
image used – and for deleting or hiding transit maps that is not in use. 
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Transit Map Edit Section Overview 
  

Lines 
All lines imported 
from the Planned 
Traffic. 

Route, 
Selected Line 
The route stops, 
imported from the 
Planned Traffic, 
with additional 
placed point in 
links. 

View/Hide, Delete, Save Line Buttons 
Use these function buttons to view/hide, delete and save the 
corresponding line (route). You can for instance choose to hide all 
routes you are not editing. 

Add, Remove, Place Route point 
buttons 
Use to add point in links to make link (path) 
between two stop points more/less 
complex. Use the Place button to 
start/continue placing points on the route. 

Remove 
point button 
Use to delete 
unnecessary 
points. 
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The Transit Map Background Image 
To make a clear and easy to read transit map you need a good background image. 
Normally the transit map images that are designed for print may need editing to remove 
unneeded details, names etc. This is performed in a suitable application. 

 

• Save the image in png format in a resolution adapted to the display you are to use. 
Verify that the image quality is ok at the zoom levels you are to use in practice. 

 

 

 

The Transit Map Stops and Paths 
To display and position the real-time vehicle symbols in the Transit Map, the application 
need you to define the position of all stops and the paths or “links” between them – 
based on the planned traffic data. To do this you extract line data, stop points and routes 
from the Planned Traffic and “place” them om the map, using the Transit Map editing tools. 

 

• Note: As the application need to reference the complete planned traffic to place the 
vehicle symbols along the line patths, you need to place all stop points of the selected 
line routes on the map, even if they are not included in the simplified background 
image. As the Traffic Studio stop points can be hidden in the view without loss of 
functionality (shortcut menu access) this should not be a problem. 
 

• The paths between stop points may be simple straight lines, or they may consist of any 
number of sections forming “curves” etc. These “links” are created by placing “point-in-
links” along the intended path when you create the Transit Map. 

  

Cleaning up a Transit Map 
backround Image. 
 
For maximum clarity, you can 
remove unneeded details in the 
image. Edit the vector format 
original image for best results. Then 
save the image in .png format in 
optimal resolution. 
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Creating a New Transit Map 
 

 In My Transit Maps, enter the name of the new Transit Map in the name field: 

 

 Click on the Browse button to open the browse window. Browse to the (png) image 
that is to be used as background and select it. 

 

 Click on the “Add” button to add the new transit map to the list above. 

 

 

 Click on the “Show in Transit Map tool” button to view the new transit map in the top 
Transit Map window. 



Traffic Studio Super User Reference Manual 
 

Ver.25.7.(X)   47 /54  

 

 

 
 

 

Privileged 

 

 Verify that the background image will work OK (resolution at different zoom levels, 
image quality etc.). See the reference manual for how to use the Transit map tool. 

 Enable Transit Map Edit mode with the (top) Edit button in the Transit map tool, see 
below. 

  

 Add the first line to the Transit Map by selecting “Insert into Transit Map [name]” in the 
Planned Traffic tool Lines list shortcut menu, see below. 

 

The line is added to the Lines list in the Transit Map edit section, to the left in the tool 
window. 
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 Now, add a suitable line route the same way from the Planned Traffic tool. Expand the 
route node, right-click on the route and select “Insert into Transit Map [name]”. The 
route with all its stops is inserted into the Route links section of the (already) selected 
line, see below. 

 

 

 

 Place the stops along the route on to the map by clicking on the “place” button of the 
first stop in the series, see below. Then position the mouse pointer over the correct 
place on the background image followed by pressing “A” on the keyboard. The stop 
point will be placed on to the map. You can now proceed with either placing the next 
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stop (using the “A” key) or inserting a path point-in-link using the “S” key on the 
keyboard. 

 

 Repeat the above “point placing “ process, and create the whole line path from start to 
finish. As needed, click and drag to move any of the placed stop points or points in link 
(all new points that can be moved will have a “shadow”). 
 
Note: If needed, you can enter specific coordiates for each individual point on the map 
in the corresponding field in the route list and that way make sure everything aligns 
perfectly. 
 

 

Note: If you want to quit before placing all the stop points, press the Esc key. 
 

  

Use coordinates for 
exact 
vertical/horizontal 
placement. 
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 If you need to add point-in-links between two stop points, click on the corresponding 
“+” button  in the route list. If you need to delete a point, click on the corresponding “-“ 
button. 

 

 Save the created line route by clicking on the save button for that line in the top Line 
list. Note that you have to save each line individually. 

 

 Add more lines with stops and link paths by repeating steps 7 to 12 

 

 

Changing/Editing a Transit map 
You can at any time change/update the background image of a Transit Map or add new 
Line routes etc. (see above), but in the current version of the tool you cannot edit a line 
route already created. If needed, delete the line route (use the “- “button in the line list) 
and create it anew. 

Do not forget to save any changes by clicking on the Save button in the My Transit Maps 
tool/The save button for the new line route in the line section of the Transit Map tool, see 
below. 
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Publish/Unpublish (Show/Hide) Transit Maps 
New Transit Maps are not by default visible to all users in the Company. When your new 
Transit map is ready for use, select it in the My Transit Maps tool and then click on the 
“View” button in the edit section under the list, se below. Then click Save to save your 
changes. 

 

The “View” column checkbox will show that your Transit Map is now available for the 
user/-s. 

 

Delete a Transit map 
To delete a transit map, click on the corresponding “- “button in the My Transit maps list. 

 

Note: This will immediately delete the transit map regardless if it is in use or not. Use with 
caution. 
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14 Basic Administrative Operations, Step-By-
Step 
In this chapter, we will walk you through some basic operations crucial for setting 
up/administering a CTS system. 

 

 Add TS user from scratch (New CTS System) 

In a new system, you will need to install a first user, which can then be used for creating 
mpore users, roles, configurations, etc. 
 

Setup first user in SQL Management: 
Colour codes: Text – Paths – Functions – Replace 

Navigate to the servers SQL Server Management Studio where you want to add 
the user. 
In the following tables:  
 
[I4M].[RESOURCE].[Employee] Create an employee 
 
[I4M].[RESOURCE].[User] Add a user, link Id_Employee from previous table. 
 
[I4M].[RESOURCE].[UserUserRoles] Add the ID from [User] and add 1002 under 
Id_UserRole.  

 

The following SQL commands can be used to add data into the tables: 
 
insert into [I4M].[RESOURCE].[Employee] values('<Id>','0','consat', 
'Consat', 'Telematics', '1','Consat Se User', '0', '<XXXX-XX-XX>', '0', 
'<XXXX-XX-XX>', 'NULL', 'NULL', 'NULL') 
insert into [I4M].[RESOURCE].[User] 
values('<Id>','<Id_Employee>','consat', '<Password>') 
insert into [I4M].[RESOURCE].[UserUserRoles]  
values('<Id>','<Id_user>','1002', 'NULL', '<XXXX-XX-XX>') 

 

In Traffic Studio: 
 Login: Enter username and password, close the Role Selection window by pressing 

the X button. Do not press cancel. 

 Open File/Setup/Configuration Manager, press Add New and add a new import role. 
Press Save and then Load.  
 

Select File/Setup/Tool (Plug-in) Manager, add the 
Tmix.Cap.InternalTool.Plugin.UserManger.dll. 
 
Close the window and navigate to File/Setup/Systems. Press Add and fill in 
Name, Key Code, Host. 
Add the desired functions in the tab Services and fill in Planned Traffic, 
Username, and Password. 
Press Apply and Close. 
 



Traffic Studio Super User Reference Manual 
 

Ver.25.7.(X)   53 /54  

 

 

 
 

 

Privileged 

Open Tool (Plug-in) Manager, add the desired plugins. Press OK and navigate 
back  
Configuration Manager.  
Press Save and then close it. 
 
Thereafter connect to Traffic Studio. 

Open TrafficStudio and navigate to User Manager under tools. 
In the tab Users and User roles you can now add users more easily, you will still 
need to do step 2 to configure the new Users/User roles. 

 

 Add a TS Operator to a new system 

 

 Login to Traffic Studio as Superuser and if needed connect to the central system. 

 In the User Manager Tool – add at least one User Role, including role grant 
configuration - see Chapter Fel! Hittar inte referenskälla., page Fel! Bokmärket är inte 
definierat. for how to do this. 

 Create a User (if needed) and assign one or more of the above roles to the user, or 
assign user role(s) to an existing user, see Chapter Fel! Hittar inte referenskälla., page 
Fel! Bokmärket är inte definierat. for how to do this. 
 
 

 Navigate to the server where you want to add the user and open SQL Server 
Management. 

[APT].[DBO].[APT_Company] 
 

 Use this table to locate the company_id needed for the APT_Company_Access table. 
 
[APT].[DBO].[APT_Company_Access] 
 
Note! Do not add data to this table! 
 

 Add the key_string and link the company_id from the APT_Company table. 
  
[APT].[DBO].[APT_Users] 
 

 Add a username and password, link the key_string to the APT_Company_Access 
table. 
 

 
Note: Username and Password can have a maximum of 16 characters. 
 

The following SQL commands can be used to add User data into the tables 
(replace color-coded text below): 
 
insert into [APT].[dbo].[apt_company_access] values('<key_string>', '<company_id>', 
'1', '0', '<XXX-XX-XX>', '', 1) 
 
insert into [APT].[dbo].[apt_users] values('<username>', '<password>', '<key_string>', 
'<XXX-XX-XX>', '2038-01-01', getdate(), '', 1) 
 
 

 Disconnect Traffic Studio from the Central System 

User Data in 
SQL Server 
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 Open the Configuration Manager and create a new configuration (including toolset, 
key code, services, etc.) connected to a User Role created in step 2, see chapters Fel! H
ittar inte referenskälla. and Fel! Hittar inte referenskälla. for how to do this. 

 Save the configuration in Configuration Manager. 

 Reconnect Traffic Studio and verify that the new operator is up and running. 

 


